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VIVOTEK

Overview

VIVOTEK VC8201 is a split-type camera system, which the camera unit and the video core are

separated. With the separated design, it enables the camera unit to be much smaller, making in-
stallation easier as well as blending in decoration easily. In addition, the VC8201 can connect up
to two 5-Megapixel camera units with 8-meter long cables, dramatically saving installation effort.

The camera units CU8131 and CU8171 are designed as recessed dome type, in order to fit in
the decoration. The CU8131 is equipped with a 1MP sensor and features WDR Pro technology,
allowing the camera to capture clear images with high-contrast scenes. The CU8171 is built
with a SMP sensor and fisheye lens to provide a 360° surround view without blind spots. The
VC8201 can support different combinations of two camera units, making the installation more
flexible.

Incorporating a number of advanced features of VIVOTEK cameras, including 3DNR, tamper
detection, 802.3af compliant PoE, SD/SDHC/SDXC card slot, and VIVOTEK’s 32-channel re-
cording software, the VC8201 is the best solution of indoor video surveillance.

Revision History

Rev. 1.0: Initial release.
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Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera is not
only a high-performance web-ready camera but can also be part of a flexible surveillance system. It is
the user’s responsibility to ensure that the operation of such devices is legal before installing this unit for
its intended use.

It is important to first verify that all contents received are complete according to the Package Contents
listed below. Take note of the warnings in the Quick Installation Guide before the Network Camera is
installed; then carefully read and follow the instructions in the Installation chapter to avoid damage due to
faulty assembly and installation. This also ensures the product is used properly as intended.

The Network Camera is a network device and its use should be straightforward for those who have basic
networking knowledge. It is designed for various applications including video sharing, general security/
surveillance, etc. The Configuration chapter suggests ways to best utilize the Network Camera and
ensure proper operations. For creative and professional developers, the URL Commands of the Network
Camera section serves as a helpful reference to customizing existing homepages or integrating with the
current web server.

Package Contents

m VC8201 camera and lens modules m RJ12 Lens Cables
m Mounting bracket m Quick Installation Guide
m Alignment Stickers m Software CD

m Screws and anchors

Symbols and Statements in this Document

INFORMATION: provides important messages or advices that might help prevent inconvenient
or problem situations.

NOTE: Notices provide guidance or advices that are related to the functional integrity of the
machine.

%

1/
1N

Tips: Tips are useful information that helps enhance or facilitae an installation, function, or
process.

WARNING! or IMPORTANT!: These statements indicate situations that can be dangerous or
hazardous to the machine or you.

Electrical Hazard: This statement appears when high voltage electrical hazards might occur
to an operator.

> B



Introduction

The two sensor modules can be installed in the same or different rooms/mounting positions.
A fisheye lens can be used to cover an entire space, while a fixed focal lens a specific field of
view.

Fisheye lens module

Fixed lens module

Fisheye lens module

Fisheye lens module




Hardware Installation

Drill a hole on ceiling or wall. The diameters for the installations with or without the
retention tube are different.

50mm

w/ the retention tube

45mm

Use the M3 self tapping screws if installed without the retention tube. Note that this type of
installation does not apply to hard surfaces, such as a concrete wall.

1. Detach the top cover.
2. Install the retention tube.
3. Route the sensor cable through the hole, and then connect to the lens module.




Pull the retention clips to the back of the module, and then insert the module into the wall.

Use an extension tube if the wall is thicker than 6cm.

The retention clips will hold the module in place.

Note that the shooting angle of a fixed lens can
only be vertically adjusted. This mark should be
on top.




Route and connect the R12 sensor cables.

Install the camera main assembly to wall. Secure the mount bracket to the sides of the
assembly, and use the screw holes on the bracket as the drilling template. Drill holes, hammer
in the anchors, and install the main assembly to a wall.

— —
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1. Connect 12V DC power and an Ethernet cable to the network. The camera can also be
powered by a PoE connection (up to 11.5W).

2. If preferred, install an SD/SDHC/SDXC card.

3. Connect DI and DO devices. The max. load on a DO pin is 50mA.

Reset
| LEDs
| @
0
@

DI/DO
ltem LED Status Description
1 Steady Red Power on and system booting
Red LED off Powered off

2 Steady Red + blinking Green every 1 sec. (Green|Network heartbeat
LED on for 1 sec and off for another)
Steady Red + Green LED off Network disconnected
3 Blinking Red every 0.15 sec. + Blinking Green|Upgrading firmware
every 1 sec. (Red LED on for 0.15 sec. and Green
LED on for 1 sec. and off for another)

4 Blinking Red every 0.15 sec. + blinking Green|Restoring defaults
every 0.15 sec




1. Use a small-size Phillips screwdriver to change the shooting angle of a fixed focal lens.

2. Remove the protective cap from a fisheye lens.

3. Attach the top cover to lens module by aligning the notch. The magnets will hold the cover in
place.

Fixed lens module Fisheye lens module



DI/DO Diagram

Please refer to the following illustration for the connection method.

BJT transistor

GND r!1 GND ¢
L L
= VvDC =
Camera Power 3 Camera Power VvDC

H +12
3 ; ; VDC

Input * Switch +12 Input SV:I/tCh
L]

Output r:1 Output i
U

Hardware Reset

The reset button is used to reset the system or restore the factory default settings. Sometimes
resetting the system can return the camera to normal operation. If the system problems remain
after reset, press the reset button longer to restore the factory settings and install again.

Reset: Press and release the recessed reset button with a straightened paper clip. Wait for the
Network Camera to reboot.

Restore: Press and hold the recessed reset button for at least several seconds to restore. Note
that all settings will be restored to factory defaults.
SD/SDHC/SDXC Card Capacity

This network camera is compliant with SD/SDHC/SDXC 32GB, 64GB, and other preceding
standard SD cards.



Network Deployment

Setting up the Network Camera over the Internet

There are several ways to set up the Network Camera over the Internet. The first way is to set
up the Network Camera behind a router. The second way is to utilize a static IP. The third way is
to use PPPoE.

Internet connection via a router

Before enabling the access to the Network Camera over the Internet, make sure you have a
router and follow the steps below.

1. Connect your Network Camera behind a router, the Internet environment is illustrated below.
Regarding how to obtain your IP address, please refer to Software Installation on page 17 for
details.

- r =
| E
|

\ 5
. -

WAN (Wide Area Network ) / IP address : 192.168.0.3

Router IP address : from ISP Subnet mask : 255.255.255.0
Default router : 192.168.0.1

Internet

LAN (Local Area Network)
Router IP address : 192.168.0.1

< y:
Cable or DSL Modem \ j
IP address : 192.168.02

Subnet mask : 255.255.255.0
Default router : 192.168.0.1

2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.
m Secondary HTTP port: 8080
m RTSP port: 554
m RTP port for audio: 5558
m RTCP port for audio: 5559
m RTP port for video: 5556
m RTCP port for video: 5557
If you have changed the port numbers on the Network page, please open the ports
accordingly on your router. For information on how to forward ports on the router, please refer
to your router’s user’s manual.

3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).
Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 65 for details.



For example, your router and IP settings may look like this:

Device IP Address: internal  |IP Address: External Port (Mapped port on the
port router)

Public IP of router [122.146.57.120
LAN IP of router 192.168.2.1
Camera 1 192.168.2.10:80 122.146.57.120:8000
Camera 2 192.168.2.11:80 122.146.57.120:8001

Configure the router, virtual server or firewall, so that the router can forward any data coming
into a preconfigured port number to a network camera on the private network, and allow data
from the camera to be transmitted to the outside of the network over the same path.

From Forward to
122.146.57.120:8000 [192.168.2.10:80
122.146.57.120:8001 |192.168.2.11:80

When properly configured, you can access a camera behind the router using the HTTP request
as follows: http://122.146.57.120:8000

If you change the port numbers on the Network configuration page, please open the ports ac-
cordingly on your router. For example, you can open a management session with your router to
configure access through the router to the camera within your local network. Please consult your
network administrator for router configuration if you have troubles with the configuration.

For more information with network configuration options (such as that of streaming ports),
please refer to Configuration > Network Settings. VIVOTEK also provides the automatic port for-
warding feature as an NAT traversal function with the precondition that your router must support
the UPNP port forwarding feature.

Gt # pddress autcrmahoaby

e Fed P address

alfeamang pf oiaoie ¢ Ennbke UPne presenimlon

oo 4] Enabée UPsP porl lerwarding

L] PREsE

ENELT ¥ Enabie P&

The device m configunng now. Wiser Browaer will neconnact

Socurity IPvh oy o btp WS2 (B84 {a B
i H'itha conndcton. (e, Dlass manualy anbev ihe sbove P
Pz aniady
BIANERR I dcat BYDw BT ———
l | L
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Internet connection with static IP

Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN configuration on page 65 for details.

Internet connection via PPPoE (Point-to-Point over Ethernet

Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to

PPPoE on page 85 for details.

Set up the Network Camera through Power over Ethernet (PoE)

When using a PoE-enabled switch
The Network Camera is PoE-compliant, allowing transmission of power and data via a single

Ethernet cable. Follow the below illustration to connect the Network Camera to a PoE-enabled

ﬁ NOTE:

switch via an Ethernet cable.

1. The camera is only to be connected to PoE networks
without routing to outside plants.

2. For PoE connection, use only UL listed I.T.E. with PoE
output.

Power + Data Transmission

PoE Switch

When using a non-PoE switch
If your switch/router does not support PoE, use a PoE power injector (optional) to connect

between the Network Camera and a non-PoE switch.

PoE Power Injector
(optional)

Non-PoE Switch



General Connection (without PoE)

1. If you have external DI devices, make the connection from general |/O terminal block.
2. Ethernet, power and IO cables are user-supplied.
3. Connect DC power cord to a DC Adapter, and then to a power outlet.

) NOTE:

The power adapter should comply with L.P.S.
regulations featuring O/P: 12V DC, 1.5A min.



Software Installation
Installation Wizard 2 (IW2), free-bundled software included on the product CD, helps you set up

your Network Camera on the LAN.

Installation
Wizard 2

1. Install IW2 under the Software Utility directory from the software CD.
Double click the IW2 shortcut on your desktop to launch the program.

2. The program will conduct an analysis of your network environment.
After your network environment is analyzed, please click Next to continue the program.

Installation Wizard 2 Installation Wizard 2
Your nebwork environment was analyzed as below
Private DHCP
The wizard ix anabyzing your netwark snvinsnmant
= 3} Plessewaltamoment
Fa
<> = e
(jhh..l..l-ll. ok I
e I_ E -
ULLLLEELLLLLEEEL] *H.,‘%
Esit Carcl [ ee | m
TS

3. The program will search for all VIVOTEK network devices on the same LAN.

4. After a brief search, the main installer window will pop up. Double-click on the MAC address
that matches the one printed on the camera label or the S/N number on the package box label
to open a browser management session with the Network Camera.

e A {\u ]

Network Camera %/Vl\l@'EK
Model No: VC8201
MAC 0002D1 083236 XXXXX ggﬁ; MAC 1P Address Model

00-02-D1-08-32-36 192.168.5.109 VC8201
T A |

ﬁ RoHS % 0002D1083236

I
This device complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference
that may cause undesired operation.

Pat. 6,930,709 Made in Taiwan

FRTEEE Installation Wizard 2

| @

Please check the MAC and model name in the Network Camera ¥ wivorm
product label of your device first. Model HO: BT7HIT 0560 ()
Then, you can start to link to your device and

show the main screen by double clicking the 1 H

item in the above selection list. (=4

If you are not able to find your device in the
ahove selection list, please make sure all
cables are properly connected to your device
and then click on the "Refresh Devices"
button.

You can find the product label in
the rear/bottom part of your
device.




Ready to Use

1. A browser session with the Network Camera should prompt as shown below.

2. You should be able to see live video from your camera. You may also install the 32-channel
recording software from the software CD in a deployment consisting of multiple cameras. For
its installation details, please refer to its related documents.

?;IUW@:EH Mega-Pixel Network Camera
Vickio stewam ke T EEN RS | BT Clent settings  Configuration | Language

Channd 1

Display Mo oo
F Mansal brgs :
Channd 7

[agetal nips =7
i
1

[ e | P ]
pm-sp;__; — .0 4
Tifl mpessncd o
Toom spood [
Farceamic spaed 1
Fckils spesd

ﬁ NOTE:

If you encounter problems with displaying live view or the onscreen plug-in control, you may try
to remove the plug-ins that might have been installed on your computer. Remove the following

folder: C:\Program Files (x86)\Camera Stream Controller\.



Accessing the Network Camera

This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and VIVOTEK recording software.

Using Web Browsers

A IMPORTANT:

Currently the Network Camera utilizes 32-bit ActiveX plugin. You CAN NOT open a
management/view session with the camera using a 64-bit IE browser.

If you encounter this problem, try execute the lexplore.exe program from C:\Windows\
SysWOW64. A 32-bit version of IE browser will be installed.

On Windows 7, the 32-bit explorer browser can be accessed from here: C:\Program Files
(x86)\Internet Explorer\iexplore.exe

Use Installation Wizard 2 (IW2) to access to the Network Cameras on the LAN.

If your network environment is not a LAN, follow these steps to access the Netwotk Camera:

1. Launch your web browser (e.g., Microsoft® Internet Explorer, Mozilla Firefox, or Netscape).

2. Enter the IP address of the Network Camera in the address field. Press Enter.

3. The live video will be displayed in your web browser.

4. If it is the first time installing the VIVOTEK network camera, an information bar will prompt as
shown below. Follow the instructions to install the required plug-in on your computer.

|‘ e — —::Sﬂb_-.g = = T o [

| e
e i T T T ST R TT e P

*.?TU:-‘_EK Mega-Pixel Network Camera
p—— S . = — ——— a
J— i i o = o, e D of ki o ol M

B CESTRCHENESD PN e -.:.-.-




NOTE:

For Mozilla Firefox users, your browser will use Quick Time to stream live video. If you do not
have Quick Time on your computer, please download Quick Time from Apple Inc's website, and
then launch your web browser.

ma BE e G femmam fen e B e Ry peess S
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-@— Tips:
* The onscreen Java control can malfunction under the following situations:

A PC connects to different cameras that are using the same IP address (or the same camera
running different firmware versions). Removing your browser cookies will solve this problem.

* In the event of plug-in compatibility issues, you may try to uninstall the plug-in that was previ-
ously installed.

| Business Explorer

, Camera Stream Controller

¢ Uninstall

| Catalyst Control Center

am



NOTE:

1. By default, your Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to configure a password for your camera later. For more information
about how to enable password protection, please refer to Security on page 83.

2. If you see a dialogue box indicating that your security settings prohibit running ActiveX
Controls®, please enable ActiveX Controls for your browser.

To enable the ActiveX® Controls for your browser:

2-1. Choose Tools > Internet Options >

Security > Custom Level.

General | Secunity | Privacy | Content | Connections | Programs | Advanced
Select a'web content zone to zpecify itz security settings.
2 0 @
Local intranet  Trusted sites  Restricted
sites

Internet

Thiz zone containg all ‘Web sites you
haven't placed in ather zones

Security level for this zone

Custom
Cusztom settings.
- To change the settings, click Custam Level.
- To uge the recommended settings, click Default Level.

[ Cusztomn Level... ] Default Lewvel ]

[ 0K H Cancel ]

2-2. Look for Download signed ActiveX® _
controls; select Enable or Prompt. Click OK. Security Settings FIX

Setkings:

controls and plug-ins A
E] Download signed Activel controls
() Disable
II:_:ZI Enable
(@) Prompk
|¥] Download unsigned Activex controls
() Disable
(®) Enable
{_) Prompt
g Initizlize and script Activey controls not marked as safe
() Disable
(®) Enable

[ ) Prompt
l n__ Aakiiiabt! cemboele cemd ol - e b
< >
Reset cusbom settings
Reset to: | Medium v

[ 4 ][ Cancel l

2-3. Refresh your web browser, then install the ActiveX® control. Follow the instructions to
complete installation.



Using RTSP Players

To view the H.264 streaming media using RTSP players, you can use one of the following
players that support RTSP streaming.

€21 Quick Time Player
= VLC Player
[, -

1. Launch the RTSP player.

2. Choose File > Open URL. A URL dialog box will prompt.

3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
stream1 to stream4>

As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 73.
For example:

Enter an Intemet URL to open:

rtsp://192.168.5.151:554, v

4. The live video will be displayed in your player. For more information on how to configure the
RTSP access name, please refer to RTSP Streaming on page 73 for details.

e Eel

The RTSP players will show the original circular-shape image. You can access the Regional
views via the ST7501 or VAST software. See page 74 for an example.



Using 3GPP-compatible Mobile Devices

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page

13.
To utilize this feature, please check the following settings on your Network Camera:

1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 73.

2. As the the bandwidth on 3G networks is limited, you will not be able to use a large video size.
Please set the video and audio streaming parameters as listed below.
For more information, please refer to Stream settings on page 59.

Video Mode MPEG-4
Frame size 176 x 144
Maximum frame rate 5 fps
Intra frame period 1S

Video quality (Constant bit rate) 40kbps
Audio type (GSM-AMR) 12.2kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 73.

4. Launch the player on the 3GPP-compatible mobile devices (e.g., Real Player).

5. Type the following URL commands in the URL field.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming
access name for stream 3>.
For example:

Enter an Internet URL to open:
rtsp://192.168.5.151:554 -




Using VIVOTEK Recording Software

The product software CD also contains recording software, allowing simultaneous monitoring
and video recording for multiple Network Cameras. Please install the recording software; then
launch the program to add the Network Camera to the Channel list. For detailed information

about how to use the recording software, please refer to the user’s manual of the software or
download it from http://www.vivotek.com.
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http://www.vivotek.com

Main Page

This chapter explains the screen elements on the main page. It is composed of the following
sections: VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, and Live

Video Window.

VIVOTEK logo Resize Buttons
Configuration
Area
1 vivern Host name <——Hega-Fixal Network Camara T

——g
e

g | (e

Camera Control | ==

Panel — ———:

S -[ '. i

L]
VIVOTEK INC. Logo

Click this logo to visit the VIVOTEK website.

Host Name
The host name can be customized to fit your needs. For more information, please refer to System > General

Settings on page 42.

Video stream

Since this camera connects to two lens modules, use this menu to display the video stream from either
one of them. The lens modules are indicated as Channel 1 and Channel 2. On a web console, you can
select to display any of the three video streams from each channel.
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NOTE:

Skip this section if you do not apply fisheye lens modules in your configuration.

Display mode: (This menu only displays when a fisheye lens module is attached)

This is a configuration menu exclusively designed for Fisheye lens. Due to the fisheye lens’ wide
coverage of 180° hemispheric and 360° panoramic views and to manipulate the details within, the
following display modes are provided:

Video stream 1

Display mode 1P
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105R
4R

A 4R PRO
108R

10 - One Original fisheye view.

1P - One Panoramic view

1R - One Regional view

1P2R - One Panoramic and two Regional views (Wall mount)
2P - Two Panoramic views

1P3R - One Panoramic and three Regional views (Wall mount)
103R - One Original and three Regional views

4R - Four Regional views

4R PRO - Four Regional views interactively displayed when the field
of view changes in any of the views

108R - One Original and eight Regional views

* Most display modes are available in the Ceiling mount type.
* See following discussions for detailed explanation of these modes. If
selected, the Wall mount type provides another two distinctive modes.



10 (Original) Display mode: 10 View (Original View)

When mounted on a ceiling, the fisheye camera can

cover an approximately 50 m? of surveillance area (hung @
at a height of approximately 3 meters), while still keeping
details in videos with recognizable facial features of
people trafficking through the area.

180° Hemispheric

The 10 view is especially adequate for taking an over-
view glimpse of surveillance area with a ceiling mount
camera.

1P (Single Panoramic) Display mode:

With image correction algorithms, the hemispheric image is transformed into a rectilinear stripe in the 1P
display mode. Viewers can use the PTZ panel or simply use mouse control to quickly move through the
360° panoramic view. (Mouse control on the Panoramic view is available with the Ceiling mount type.)
Note that the 1P view is apt for an overview, the Zoom in/Zoom out function does not apply in this mode.
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1R (Single Regional) Display mode:

The 1R mode provides access to one image section within the hemisphere. You can zoom in or out
(using the mouse wheel or PTZ panel) or travel to other areas in the hemisphere using mouse clicks and
swipes. A single click on a particular object can bring the object to the center of your view window. Click
and hold down the left mouse button, and you can swipe the view both horizontally and vertically.

1R View (Single Regional View)

il
m Out

Zoom in/Zoom out
&
all-directional
navigation control

2P (Dual Panoramic View) Display mode:

Similar to 1P, the 2P display mode provides simultaneous access to both the left and right sections of a
hemisphere. Both panoramic views are corrected into a more viewable dewarped image. Viewers can
use a mouse click and swipe to quickly scroll horizontally through the surveillance area.

* Note that the dividing line falls approximately on the center of the VIVOTEK logo.

2P View (Panoramic View) Converted to rectilinear view (Dewarp)
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103R (One Original & Three Regional) Display mode:

The 103R mode provides access to multiple live view sections within the hemisphere and the reference
to their relative positions on an Original circular view. The FOV indicators (#1 ~ #3) interact with your
current operation as you may zoom in/out or move the live view window to a different place.

You can zoom in or out or travel to other areas within the hemisphere using identical methods as
previously described in the 1R mode.

You can also change the locations of Regional views by dragging the FOV indicators on the "Original"

circular view.

103R (Original & Regional) Mode Screen Control
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Pan or tilt

Current screen selection

In a Regional view displaying 100% of video feed (via the Resize buttons - see page 32), your
mouse wheel can be used to scroll the view window vertically before you click on a live image.
After you click on the live image, the mouse wheel becomes the zoom in/zoom out tool.



4R (Four Regional) Display mode:

The view control and look and feel are identical to that as described in the 1O3R mode except the

absence of the Original circular view.

4R PRO (Four Regional Proactive) Display mode:
The 4R PRO mode is similar to the 4R mode except that the quad view windows consecutively rotate in

correspondence to the change of view area in one window. Note that zoom in/out and tilt control is not
available in this mode.

108R (One Original and Eight Regional) Display mode:
The view control and look and feel are identical to that as described in the 1O3R mode.

Note that if you change the position of a view in hemisphere, e.g., #3 window, you may lose the
configuration change by switching to another display mode. The live view window does not automatically

save your view section layout.
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1P2R (One Panoramic and Two Regional) Display mode:
1P3R (One Panoramic and Three Regional) Display mode:

These two modes are only available with the Wall Mount type! The Mount type configuration is found in
Configuration > Media > Image > General Settings. Please refer to page 52 for details.

The view control in these two modes is identical to that as described in the 1O3R mode.

Mega-Pixel Network Camera
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Video Stream: This Network Camera supports multiple streams (channel # and stream #1 ~ #3)
simultaneously. You can select any one of them for live viewing. For more information about multiple
streams, please refer to page 59 for detailed information.

Manual Trigger: Click to manually enable or disable an event trigger. Please configure an event setting
before enabling this function. A total of 3 or 4 event settings can be configured. For more information
about event setting, please refer to page 99. If you want to hide this item on the homepage, please go
to the System > Homepage Layout > General settings > Customized button to deselect the “show
manual trigger button” checkbox.

Digital Output: Click to turn the digital output device on or off.

PTZ Control Panel:

Up
f Return to Home Position
Left —F 31 & Right
Down v
Zoom Out — ] Zoom |+ Zoom In
Start to Auto Pano Frano. | stop [ Rotats Rotate

Stop Auto'Pano

Pano.: Click this button to start the automated circular rotation through a regional view (360° continuous
rotation). Note that this function does not apply in a Panoramic view because a Panoramic view already
shows the full coverage.

Stop: Click this button to stop the Auto Pano and Auto Rotate functions.

Rotate: This allows the current regional view to move from one preset position to another in a
consecutive order.

Pan speed Tilt speed Zoom speed Panoramic Rotate speed
speed
-5 -5 -5 - - Slower
-4 -4 -4 - -
-3 -3 -3 - -
-2 -2 -2 - -
-1 -1 -1 -
0 0 0 0 0
1 1 1 1 1
2 2 2 2 2
3 3 3 3 3
4 4 4 4 4
5 5 5 5 5 Faster

Pan /Tilt /ZZoom /Panoramic/Rotate speed: Adjust the speed of these controls when exerted:

Configuration Area

Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 37.



Configuration: Click this button to access more of the configuration options provided with the Network
Camera. It is suggested that a password is applied to the Network Camera so that only the administrator
can configure the Network Camera. For more information, please refer to the description for the
Configuration menus on page 41.

Language: Click this button to choose a language for the user interface. Language options are available
in: English, Deutsch, Espafiol, Frangais, Italiano, HAZE, Portugués, A3, and EEEH . You can
also change a language on the Configuration page; please refer to page 41.

Hide Button
You can click the hide button to hide the control panel or display the control panel.

Resize Buttons

IEm|E1m%|EED%|EEE%|:

Click the Auto button, the video cell will resize automatically to fit the monitor.
Click 100% is to display the original homepage size.

Click 50% is to resize the homepage to 50% of its original size.

Click 25% is to resize the homepage to 25% of its original size.

Live Video Window

m The following window is displayed when the video mode is set to H.264:

H.264/MPEG-4 Protocol and Media Options ]
Time

Video Title

Video|(TPC-AV)

Title and Time [Video 13:59:05 2012/07/04 [N

sy

l—> Video and Audio Control Buttons

Video Title: The video title can be configured. For more information, please refer to Video settings on
page 59.

H.264 Protocol and Media Options: The transmission protocol (TCP or UDP, etc.)and media options for
H.264 video streaming. For further configuration, please refer to Client Settings on page 37.

Time: Display the current time. For further configuration, please refer to Media > Image > Genral settings
on page 52.

Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Media > Image > Genral settings on page 52.

Video and Audio Control Buttons: Depending on the Network Camera model and Network Camera
configuration, some buttons may not be available.




K3 Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

IE' Pause: Pause the transmission of the streaming media. The button becomes the | * | Resume button
after clicking the Pause button.

#  Stop: Stop the transmission of the streaming media. Click the | * Resume button to continue
transmission.

| » | Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the |E| Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving

Options on page 38 for details.

@ Volume: When the |"¥2| Mute function is not activated, move the slider bar to adjust the volume on the
local computer.

0 Mute: Turn off the volume on the local computer. The button becomes the A Audio On button after
clicking the Mute button.

& Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.



m The following window is displayed when the video mode is set to MJPEG:

Video Title Video|(HTTP-V) 2011/03/10 17:08:56
Title and Time Video 17:08:56 2011/03/10_1‘

Time

Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Media > Image on
page 52.

Time: Display the current time. For more information, please refer to Media > Image on page 52.

Title and Time: Video title and time can be stamped on the streaming video. For more information, please
refer to Media > Image on page 52.

Video Control Buttons: Depending on the camera model and your current configuration, some buttons
may not be available.

E Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

F Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the El Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving
Options on page 38 for details.

@ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.

Please refer to page 96 for PTZ settings.
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VIVOTEK
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1. The onscreen Java control can malfunction under the following situations: A PC connects to
different cameras that are using the same IP address (or the same camera running different

firmware versions). Removing your browser cookies will solve this problem.

2. If you encounter problems with displaying the configuration menus or Ul items, try disable
the Compatibility View on IE8 or IE9.

I8 Ritp//wwiw joinsmsn.com/

You may also press the F12 key to open the developer tools utility, and then change the
Browser Mode to the genuine IE8 or IE9 mode.

HTML =~ €55 Console Script Profiler MNetwork ~ Intemet Explorer 7 | R

X E 4 o HE Intemet Explorer

'V Internet Explorer 9
i - <!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.8 |V Intemet Explorer

- <html xmlns="http://www. /1999 xhtml™> Internet Explorer 3 Compatibility View

36 - User's Manual




Client Settings

This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.

H.264 Media Options

H.264 media options

@ Yideo and audio
Wideo only

Audio only

Select to stream video or audio data or both. This is enabled only when the video mode is set to H.264.

H.264 Protocol Options

H.264 protocol options

UDP Unicast
UDP hMuficast
@ TCP

HTTP

Depending on your network environment, there are four options with the transmission protocols with
H.264 streaming:

UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.

UDP _multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 73.

TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of using the UDP
protocol.

HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users behind a firewall can utilize this protocol to allow
camera’s streaming data to pass through.



MP4 Saving Options

MP4 saving options
Folder: DiRecord3 Browse...

File name prefic. | cLIP
V| Add date and time suffix to file name

Users can record live video as they are watching it by clicking the B “Start MP4 Recording” button on
the main page. Here, you can specify the storage destination and file name.

Folder: Specify a storage destination for the recorded video files.

File name prefix: Enter the text that will be appended to the front of the video file name.

Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.

( )
CLIP_20110328-180853

1

File name prefix Date and time suffix
The format is: YYYYMMDD_HHMMSS

Local streaming buffer time

Local Streaming Buffer Time

0 Millisecond

| save |

Due to possible occurrences of unsteady network transmission, live streaming may lag and not be very
smoothly. If you enable this option, the live streaming will be stored on the client PC’s cache memory
for a few seconds before being played on the client computer’s live view window. This helps produce
a smoothlier live streaming. If you enter a vlue of 3,000 milliseconds, the streaming will delay for 3
seconds.



Joystick settings

Enable Joystick

Connect a joystick to a USB port on your management computer. Supported by the plug-in
(Microsoft’s DirectX), once the plug-in for the web console is loaded, it will automatically detect if
there is any joystick on the computer. The joystick should work properly without installing any other
driver or software.

Then you can begin to configure the joystick settings of connected devices. Please follow the
instructions below to enable joystick settings.

1. Select a detected joystick, if there are multiple, from the Selected joystick menu. If your joystick
is not detected, if may be defective.

2. Click Calibrate or Configure buttons to configure the joystick-related settings.

Joystick settings

Selected joystick: | [TET NI |
[ Calibrate J [ Configure buttons ]

| Save |
) NOTE:

+ If you want to assign Preset actions to your joystick, the preset locations should be configured in
advance in the Configuration > PTZ page.

» If your joystick is not working properly, it may need to be calibrated. Click the Calibrate button
to open the Game Controllers window located in Microsoft Windows control panel and follow the
instructions for trouble shooting.

* The joystick will appear in the Game Controllers list in the Windows Control panel. If you want to
check out for your devices, go to the following page: Start -> Control Panel -> Game Controllers.

2 These settings help you configure the game controllers installed on

=

Your computer.

Installed game controllers

Contraller Statuz
CH PRODUCTS IP DESKTOP COMTROLLER

Add... ] [ Remove ] [ Properties ]

[ Advanced... ][ Troublezhoat, .. l




Buttons Configuration

Click the Configure Buttons button, a window will prompt as shown below. Please follow the steps

below to configure your joystick buttons:

1. Select a button number from the Button # pull-down menu.

=Joystick settings
Actions: Patrol -
Azgsign
Button: -
wor 4 |2
|Buﬂor| § Assigned actions
| 1 ES- Toggle play/pause
| 2 |6 Snapshot
7
| 3 |z Zpom in
[ |3 Patral
z |
12
6
BN
8
9
10
11
12
< | i | »
& R | SRR B -

3. Click the Assign button to assign an
action to the button. You can delete an
association by selecting a button number,
and then click the Delete button.

Repeat the process until you are done
with the configuration of all preferred
actions.

The buttons you define should appear on
the button list accordingly.

4. Please remember to click the Save
button on the Client settings page to
preserve your settings.

-‘@'— Tips

If you are not sure of the locations of each button, use
the Properties window in the Game Controllers utility.
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=Joystick settings

Actions: Patrol |L

Start/stop recording -
Button: |Pan

Stop

Button |Zoom in =
Zoom out

Digital output on/off 1
Digital output on/off 2
Digital output on/off 3
Digital output on/off 4
Preset 1

Preset 2

Preset 3

Preset 4

Preset 5

Preset§

Preset 7

Preset 8

Preset 9

Preset 10

Preset 11

Preset12

Preset 13

Preset 14

Preset 15

Preset 16

Preset 17

Preset 18

Preset 19

<A Preset 20
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Configuration

Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.

VIVOTEK provides an easy-to-use user interface that helps you set up your network camera
with minimal effort. In order to simplify the user interface, detailed information will be hidden
unless you click on the function item. When you click on the first sub-item, the detailed
information for the first sub-item will be displayed; when you click on the second sub-item, the
detailed information for the second sub-item will be displayed and that of the first sub-item will
be hidden.

The following is the interface of the main page:

Home Client settings ESINMITEGGLE Language

System > General settings

System . .
System Navigation Area

General settings Host name: Wega-Pixel Network Camera

Home e layout
L [] Turn off the LED indicator

Logs
Parameters System time

Maintenance
Time zone: | GMT+08:00 Beiing, Chongging, Hong Kong, Kuala Lumpur, Singapore, TaipeiE

Media Mote: Wou can upload your daylight saving time rules on Maintenance page or use the camera default
value.

MNetwork -

@ Keep current date and time
Security ©) Synchronize with computer time
PTZ ) Manual

) Automatic
Event

Save

Applications

Configuration List

Recording

Local storage

Version: 0100a Firmware Version

Each function on the configuration list will be explained in the following sections.

The Navigation Area provides access to all different views from the Home page (for live viewing),
Configuration page, and multi-language selection.



System > General settings

This section explains how to configure the basic settings for the Network Camera, such as the
host name and system time. It is composed of the following two columns: System and System
Time.

System
System

Host name: Mega-Pixel Metwork Camera

Turn off the LED indicator

Host name: Enter a desired name for the Network Camera. The name will be displayed at the top center
of the main page.

Turn off the LED indicator: Click to disable the onboard LEDs.

System time
System time

Time zone:  GMT+05:00 Beijing. Chongaing. Hong Kena, Kuala Lumpur, Singapore, Taipei [«

Mote: You can upload your daylight saving time rules on Maintenance page or use the camera
default value.

@ Keep current date and time
Synchronize with computer time
Manual

Automatic
| Save |

Time zone : Select the appropriate time zone from the list. If you want to upload Daylight Savings Time
rules, please refer to System > Maintenance > Import/ Export files on page 49 for details.

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
power of the system is turned off.

Synchronize with computer time: Select this option to synchronize the date and time of the Network
Camera with the local computer. The read-only date and time of the PC is displayed as updated.

Manual: The administrator can enter the date and time manually. Note that the date and time format are
[yyyy/mm/dd] and [hh:mm:ss].

Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.

NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers.

Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.

When finished with the settings on this page, click Save at the bottom of the page to enable the settings.



System > Homepage layout

This section explains how to set up your own customized homepage layout.

General settings

This column shows the settings of your hompage layout. You can manually select the background and
font colors in Theme Options (the second tab on this page). The settings will be displayed automatically
in this Preview field. The following shows the homepage using the default settings:

General settings | Theme options

%iYI\{QE!(m Mega-Pixel Network

Video stream 1 -

Digital output

= Manual trigger:

r'l

:r

L
e o (11](s][c] ]

[7] Hide Powered by VIVOTEK

m Hide Powered by VIVOTEK: If you check this item, it will be removed from the homepage.

Logo graph
Here you can change the logo at the top of your homepage.
Logo graph

A customized logo (Gif, JPG or PNG) can be uploaded for main page. Itwill be resized to
160x50 pixels to replace the previous logo.

O Default & Custom

Yviverk  Yviverk

Lago link: | hitp:fiwsase vivotek.com

Browze. ..

Follow the steps below to upload a new logo:

1. Click Custom and the Browse field will appear.

2. Select a logo from your files.

3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.

5. Click Save to enable the settings.

Customized button
If you want to hide the manual trigger buttons on the homepage, please uncheck this item. This item is
selected by default.

Customized button

Show manual trigger button

Save



Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you
to choose from. The new layout will simultaneously appear in the Preview filed. Click Save to enable the

settings.

Font Color

Background Color of the
Control Area

Font Color of the

Configuration Area
Background Color of the
Configuration Area

Preset patterns

General settings | Theme options

Mega-Pixel Network

Video stream | 1

Digital output

¥ Manual trigger:

Powvvered by % YIVETE

Themes Color
Font color: #000000
@ Font color of configuration area:
= | g #FFFFFF
Font color of video title: -
Bk color of control area: #CAEAFF
p— . Bk color of configuration area: -
| ] BEk color of video area: #CAEAFE

Custom Frame calor: -
General seftings | Theme options
% viver=k
Video stream 1~ A - -
Digital output il . :ﬁr'-- -

# Manual trigger:

ol(ul[s]lo]sa il

General settings | Theme options

Mega-Pixel Network

Video stream
Digital output m

|

'.-f"\". .

v ==
1

Manual trigger:

e
e ]
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o by ¥ wiveTER

Font Color of the
Video Title

Background Color of
the Video Area

Frame Color



m Follow the steps below to set up a custom homepage:
1. Click Custom on the left column.
2. Click to select a color on on the right column.

Themes Color
Font color:
Font color of configuration area: EFFFFFF
_— g

Color Selector
Font color of video title:

Bk color of control area:
Bk color of configuration area:

[
[ ] Bk color of video area:

Custom s Custom Frame color:

Pattern

3. The palette window will pop up as shown below.

Hex: #000000 |:
Red: ] E
Green: 0 Green: E
Blue: ] Blue: E
Hue: 0 Hue: IE
Saturation: 0 Saturation: IE
Yalue: 0 \\Lalue: ’F)
[ Zsoea ]

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will be displayed in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.



VIVOTEK

System > Logs

This section explains how to configure the Network Camera to backup system log to a remote
server.

Log server settings

Log server settings

¥ Enable remote log
IP address:

port: 514

Follow the steps below to set up the remote log:

1. Select Enable remote log.

2. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.

3. When completed, click Save to enable the setting.

You can configure the Network Camera to send the system log file to a remote server as a log backup.
Before utilizing this feature, it is suggested that the user install a log-recording tool to receive system log
messages from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.
com/kiwi-syslog-daemon-overview/.
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System log

This column displays the system log in chronological order. The system log is stored in the Network
Camera’s buffer and dated events will be overwritten when the number of events reaches a limit.
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Access log

Access log displays the access time and IP address of all viewers (including operators and
administrators) in a chronological order. The access log is stored in the Network Camera’s buffer and

older events will be overwritten when the number of events reaches a limit.

System log | Access log

May 4 18:00:17 [RTSF SERVER]: Start one session, IP=182.168.4.101
May 4 19:00:39 [RTSP SERVER]: Stop one session, IP=192.168.4.101
May 4 18:00:58 [RTSF SERVER]: Start one session, IP=182 168.4.101
May 4 19:14:42 [RTSP SERVER]: Stop one session, IP=192.168.4.101
May 4 19:16:11 [RTSP SERVER]: Start one session, IP=192.168.4.101

System > Parameters

The View Parameters page lists the entire system’s parameters in an alphabetical order. If you
need technical assistance, use a text-editor program to copy and save the parameters listed on

this page. Send the parameter text file to VIVOTEK'’s technical support.

Parameters

gystem hostname="Mega-Pixel Network Camera'
system ledcff='0"

gystem date="2000/ ‘01701

system time="01:37:40"

gystem ntp='"

system timezonsindex='320'

system_daylight enakple='0"

system daylight dstactualmode="l"'
system_daylight autc begintime='HONE'
system daylight au::_end—"n-=—'NONE'
system daylight timezcnes=',-3&80,-320,-280,-240,-241,-200,-201,-1
SystTem uﬁda:e:.n:er ral="0"

system_info modelname="VCE201'

system infco extendedmodelname="VCE2Z01'
system_info_ serialnumber='000ZD12B307E"
system info firmwWareversicn="VCB2Z01-VVIE-010043°'
s¥ystem_infc language_ccunt='3'

system infc language i0='English'
system_infc language_il='Deutsch'

system info language iZ="Espafiol"

system infc language i3='Frangais'

system infc language id4="Italianc'
system_info_language i5='H&F}§"

gystem info language ig="Portugués"

system info languags i7="@E{ko i
system_info_language ig='"9iffich

gystem infc languagse ig="'

system info language i10=""

] T 3

m »



System > Maintenance

This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, eftc.

General settings > Upgrade firmware
Upgrade firmware

Select firmware file: | Upgrade |

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do not power off the Network Camera during the upgrade!

Follow the steps below to upgrade the firmware:

1. Download the latest firmware file from the VIVOTEK website. The file is in .pkg file format.

2. Click Browse... and specify the firmware file.

3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.

If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, re-
access the Network Camera.

The following message is displayed when the upgrade has succeeded.

Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.

( 7\
Starting firmware upgrade...
Do not power down the server during the upgrade.
The server will restart automatically after the upgrade is
completed.
This will fake about 1 - 5 minutes.
Wrong PKG file format
Unpack fail

(. J

General settings > Reboot

Reboot

Reboot

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the reboot process.

The device is rebooting now. Your browser will reconnect to hitp:/192.168.5.151:80/
[fthe connection fails, please manually enter the above IP address in your browser.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.



General settings > Restore
Restore

Restore all settings to factory default except settings in

Metwork Daylight saving time Custom language | Restore

This feature allows you to restore the Network Camera to factory default settings.

Network: Select this option to retain the Network Type settings (please refer to Network Type on page
65).

Daylight Saving Time: Select this option to retain the Daylight Saving Time settings (please refer to
Import/Export files below on this page).

Custom Language: Select this option to retain the Custom Language settings.

If none of the options is selected, all settings will be restored to factory default. The following message is
displayed during the restoring process.

The device is rebooting now. Your browser will reconnect to hitp:M192.168.5.151:80/
[fthe connection fails, please manually enter the above IP address in your browser.

Import/Export files

This feature allows you to Export / Update daylight saving time rules, custom language file, and
configuration file.

General settings || ImportExport files
Export files
Export daylight saving time configuration file
Export language file
Export canfiguration file
Export server status report
Upload files
Update daylight saving time rules:
Update custorn language file:
Upload configuration file:

Export daylight saving time configuration file: Click to set the start and end time of DST.

Follow the steps below to export:

1. In the Export files column, click Export to export the daylight saving time configuration file from the
Network Camera.

2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.



File Download &
Do pou want to open or zave this hle?

Marne:  config_dst.=ml
Type: =ML Document, 11,1 KB
From: 192.168.5.151

e

Open ][ Save ]I Cancel ]

harri your cornputer. 1F pau donat trust the source, do nat open o

@ W'hile files fram the Internet can be useful, some files can patentially
zave this file. What's the risk?

3. Open the file with Microsoft® Notepad and locate your time zone; set the start and end time of DST.
When completed, save the file.

In the example below, DST begins each year at 2:00 a.m. on the second Sunday in March and ends at
2:00 a.m. on the first Sunday in November.

I confip dst - Hotepad EIEE|

Filz Ede Format Wiew  felp
iy S DAy -~
<weskinsont h>F1 rst<meek irManthe-
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</ T imezarne:
<TimeZone 1d="=-2407 name="{GMr-06:00) Central Time (w5 and Camada)™ >
CSTArT T imes
wghifesi0« shifrs
<Hont he-3 </Manthe
ey Day>
ok | AonE B S i ord ik irMonT b
<Dayafweek ~sundsy< Cayofwesk =
<HOUr>2 < Hour >
a/SrartTimes
<ERdTimea
<shifte-60</shift>
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<Dayofweek »sunday</Cayotwesk >
SHOUP=Z £/ M0ur =
S EndT i mik
</ T imaTarns:
<rimezone 1d="-2417 name="{@ar-06:00) Mexdco city's &
< r

Update daylight saving time rules: Click Browse... and specify the XML file to update.

If incorrect date and time are assigned, you will see the following warning message when uploading the
file to the Network Camera.
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The following message is displayed when attempting to upload an incorrect file format.

Microsoft Internet Explorer,

! ‘_-. The File must hawve a .xmil filenanne suffix,

ok |

Export language file: Click to export language strings. VIVOTEK provides nine languages: English,
Deutsch, Espafiol, Frangais, Italiano, HZAE, Portugués, A3z, and & X,

Update custom language file: Click Browse... and specify your own custom language file to upload.

Export configuration file: Click to export all parameters for the device and user-defined scripts.

Export daylight saving time configuration file: Click Browse... to update a configuration file. Please
note that the model and firmware version of the device should be the same as the configuration file.
If you have set up a fixed IP or other special settings for your device, it is not suggested to update a
configuration file.

Export server staus report: Click to export the current server status report, such as time, logs,
parameters, process status, memory status, file system status, network status, kernel message..., and so
on.

-‘@’- Tips:

+ If a firmware upgrade is accidentally disrupted, say, by a power outage, you still have a last resort
method to restore normal operation. See the following for how to bring the camera back to work:

Applicable scenario:

(1) Power disconnected during firmware upgrade.
(2) Unknown reason causing abnormal LED status, and a Restore cannot recover normal working
condition.

You can use the following methods to activate the camera with its backup firmware:

(1) Press and hold down the reset button for at least one minute.

(2) Power on the camera until the Red LED blinks rapidly.

(3) After boot up, the firmware should return to the previous version before the camera hanged. (The
procedure should take 5 to 10 minutes, longer than the normal boot-up process). When tthis
process is completed, the LED status should return to normal.



Media > Image

This section explains how to configure the image settings of the Network Camera. It is
composed of the following tabbed windows: General settings, Image settings, Exposure, and
Privacy mask, and Pixel Calculator.

Channel Selector
Since this camera connects to two lens BT
. . General settinf, ™

modules, select a video channel first. 2
The corresponding configuration related to

each lens module will be displayed. ﬁﬁ = j
@ @

The Media options for fixed-focal and fisheye '
lens can be partly different. | Channel 2
Channel 1

General settings
Channel: 1|E|

General settings | | Image settings | Exposure | Privacy mask

Video Settings

Video title

Show timestamp and video title in video and snapshets

Peosition of timestamp and video title on image: Top -

Timestamp and video title font-size: Small -

Mount type: @ Ceiing ' Wall ) Floor
Calor: BAV @ Calor

Pow er line freguency: S0 Hz @ B0 Hz

“ideo orientation: Flip hirror

| Save |

Video title: Enter a name that will be displayed on the title bar of the live video as well as the view cell on
the ST7501 and VAST recording software.

Show timestamp and video title in videos and snapshots: Enter a name that will be displayed on the title
bar of the live video as the picture shown below.

Position of timestamp and video title on image: Select to display time stamp and video title on the top or
at the bottom of the video stream.

Timestamp and video title font size: Select the font size for the time stamp and title.




Mount type: (Fisheye lens only) There are 3 Mount types - Ceiling, Wall, and Floor.

Ceiling: The Ceiling mount type automatically delivers upside-down images. The Ceiling mode
supports the following Display modes - 10, 1P, 1R, 2P, 103R, 4R, 4R PRO, and 108R.

Wall: The Wall mount type applies to the monitoring of long, side-to-side surveillance areas, such
as when mounted on a wall facing a corridor. Different Mount types have different options with the
Display mode settings. For example, the 1P2R (1 Panoramic & 2 Regional) and 1P3R (1 Panoramic
& 3 Regional) Display modes are only available when the “Wall“ Mount type is applied.

Floor: The Display modes with the Floor mount type are identical to those for the Ceiling mount
except that the images are not vertically flipped.

Video Title and Time —§

Color: Select to display color or black/white video streams.

Power line frequency: Set the power line frequency consistent with local utility settings to eliminate image
flickering associated with fluorescent lights.

Video orientation: Flip - vertically reflect the display of the live video; Mirror - horizontally reflect the
display of the live video. Select both options if the Network Camera is installed upside-down (e.g., on the
ceiling) to correct the image orientation. Please note that the preset locations will be cleared after you
configure the flip/mirror option.




Image settings

On this page, you can tune the White balance, Image adjustment and WDR enhanced parameters. You
can configure two sets of preferred settings: one for normal situations, the other for special situations,
such as day/night/schedule mode.

Genaral smliys | Imaye seftings | | Exposure  Privacy mask
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Quality: This determines the quality of video feed on the Image settings page.
White balance: Adjust the value for the best color temperature.

m Auto: It will automatically adjust the color temperature of the light in response to different light sources.
You may follow the steps below to adjust the white balance to the best color temperature.
1. Set the White balance to Auto.
2. Place a sheet of white paper (or a color of a cool color temperature, such as blue) in front of the lens,
then allow the Network Camera to automatically adjust the color temperature.
3. Check the Off button on Fix current value to confirm the setting when the camera automatically
measured and adjusted the white balance.

m Manual: This item allows users to manually input the R gain & B gain ratios.

Image Adjustment

m Brightness: Adjust the image brightness level, which ranges from -5 to +5.
m Contrast: Adjust the image contrast level, which ranges from -5 to +5.

m Saturation: Adjust the image saturation level, which ranges from 0% to 100%. You can also select
Customize and manually enter a value.



m Sharpness: Adjust the image sharpness level, which ranges from 0% to 100%.

m Gamma curve: Adjust the image sharpness level, which ranges from 0.45 to 1, from Detailed to
Contrast. You may let firmware Optimize your display or select the Manual mode, and pull the slide bar
pointer to change the preferred level of Gamma correction towards higher contrast or towards the higher
luminance for detailed expression for both dark and lighted areas of an image.

m Noise reduction

m Enable noise reduction: Check to enable noise reduction in order to reduce noises and flickers in
image. This applies to the onboard 3D Noise Reduction feature. Use the pull-down menu to adjust
the reduction strength. Note that applying this function to the video channel will consume system
computing power.

3D Noise Reduction is mostly applied in low-light conditions. When enabled in a low-light condition
with fast moving objects, trails of after-images may occur. You may then select a lower strength level
or disable the function.

You can click on Restore to recall the original settings without incorporating the changes. When
completed with the settings on this page, click Save to enable the setting.

The following applies to a fixed-focal lens module:

m Enable low light compensation: Select this option in low light mode, and the values of sharpness and
brightness will change automatically. This function also benefits from an automated noise reduction
feature.

m WDR enchanced: This function allows users to identify more details of objects in the high contrast
environment especially for details in the shaded area. You may check the Enable WDR enhanced
checkbox, and then adjust the sensitivity (low, high) and the strength (low, medium, high) to reach the
best image quality.




Exposure

On this page, you can set the Exposure measurement window, Exposure level, Exposure mode,
Exposure time, Gain control, and Day/Night mode settings.

hanhel |1 »
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Measurement Window: This function allows users to set measurement window(s) for low light
compensation. For example, where low-light objects are posed against an extremely bright background.
You may want to exclude the bright sunlight shining through a building's corridor.

m Full view: Calculate the full range of view and offer appropriate light compensation.

m Custom: This option allows you to manually add customized windows as inclusive or exclusive regions.
A total of 10 windows can be configured. Please refer to the next page for detailed illustration.



The inclusive window refers to the “weighed window*; the exclusive window refers to “ignored window".
It adopts the weighed averages method to calculate the value. The inclusive windows have a higher
priority. You can overlap these windows, and, if you place an exclusive window within a larger inclusive
window, the exclusive part of the overlapped windows will be deducted from the inclusive window. An
exposure value will then be calculated out of the remaining of the inclusive window.

Include X

- Weighted region

Include

Exclude X

Ignored region

m BLC (Back Light Compensation): This option will automatically add a “weighted region® in the middle of
the window and give the necessary light compensation.

Exposure control:

m Exposure level: You can manually set the Exposure level, which ranges from -2.0 to +2.0 (dark to
bright).

m Flickerless: This function helps avoid the flickering on images because of the fast shutter movement
and the inconsistency between power line frequency (50 or 60Hz) and exposure time. When selected,
the exposure time will be forced to stay longer than 1/120 second. For cameras that come with fixed
iris lens, setting the exposure time to longer than 1/120 second may introduce too much lights to the
lens. Users can use this option to observe whether the result of long exposure time is satisfactory.

m Exposure time: you can split the round pointers on the Exposure time and Gain control slide bars
into two halves and drag them on the bars to designate a range of values in which firmware can
automatically adapt to. Note that Firmware will then automatically tune the Gain, Exposure time, and
Iris opening within the ranges you specified. For example, in low-light condition, you may prefer a
longer exposure time and more electronic gains. However, the noises in the image will also increase.

m Gain control: Tune the slider bar to set the Gain Control to the best image quality. Higher gain control
value will generate a certain amount of noises, and that the gain control, lighting levels, and picture
performance are closely related.

Click the Save button to preserve your configuration.

You can click Restore to recall the original settings without incorporating the changes. When completed
with the settings on this page, click Save to enable the settings.



VIVOTEK

Privacy mask
Click Privacy Mask to open the settings page. On this page, you can block out certain sensitive zones to
address privacy concerns.

General settings | Image settings || Exposure | Privacy mask

[#] Enable privacy mask

m To set the privacy mask windows, follow the steps below:
1. Click New to add a new window. A text box will appear allowing you to enter a name for the mask.
2. Use four mouse clicks to mark a square area, which is recommended to be at least twice the size of

the object (height and width) you want to cover.
3. Enter a Window Name and click Save to enable the setting.
4. Check Enable privacy mask to enable this function.

@ NOTE:

» Up to 5 privacy mask windows can be configured on the same screen.

» To delete a mask, use the red cross button and then click on the Save button.
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VIVOTEK

Media > Video

Stream settings

Channel: 1 -~

# ‘ideo settings for stream 1

¥ ‘ideo settings for stream 2

¥ Video settings for stream 3

Please follow the steps below to set up those settings for an individual stream:

1. Select a stream to configure its viewing region.

2. Choose a proper Frame Size from the drop-down list according to the size of monitored device.
3. Select the Maximum frame rate.

m The parameters of a fisheye lens' multiple streams:

1696 x 1696 ~ 192 x 192 (Selectable)
1696 x 1696 ~ 192 x 192 (Selectable)

1696 x 1696 ~ 192 x 192 (Selectable)

m The parameters of a fixed-focal lens' multiple streams:

1280 X 800 ~ 176 x 144 (Selectable) 1280 X 800 ~ 176 x 144 (Selectable)
1280 X 800 ~ 176 x 144 (Selectable) 1280 X 800 ~ 176 x 144 (Selectable)
fixed fixed

To begin the configuration, first select a video channel.

To change the frame size, frame rate, and other related settings, click on video settings for a video
stream to its individual configuration panel.
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The Viewing Window (Video Crop) function is only available on the fixed-focal lens module.

Click Viewing Window to open the viewing region settings page. On this page, you can set the Region
of Interest and the Output Frame Size for stream 1. If you prefer not to stream the full image the sensor
can capture, you can designate a smaller region of interest.
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Please follow the steps below to set up those settings for a stream:

1. Select a stream for which you want to set up the viewing region.

2. Select a Region of Interest from the drop-down list. The floating frame, the same as the one in the
Gloabl View window on the home page, will resize accordingly. If you want to set up a customized
viewing region, you can also resize and drag the floating frame to a desired position with your mouse.

3. Choose a proper Output Frame Size from the drop-down list according to the size of your monitoring
device.



Click the stream item to display the detailed information.
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This Network Camera offers real-time H.264 and MJPEG compression standards (dual Codec) for real-
time viewing.

If the H.264 mode is selected, the video is streamed via RTSP protocol. There are several parameters
for you to adjust the video performance:

= Video settings for stream 3

5 H.264
Frame size: 1696x1 696
haximum frame rate: 151hs -
Intra frame period: 18 =
YWideo guality
@ Constant hit rate:
Target bit rate: & Mbps -
Folicy: Frame rate priotity  «
Fixed gquality:
JPEG

m Frame size
You can set up different video resolutions for different viewing devices. For example, set a smaller
frame size and lower bit rate for remote viewing on mobile phones and a larger video size and a higher
bit rate for live viewing on web browsers. Note that a larger frame size takes up more bandwidth.

m Maximum frame rate
This limits the maximum refresh frame rate per second. Set the frame rate higher for smoothlier video
quality.
Regardless of the power line frequency setting (60Hz or 50Hz), the frame rates are selectable at 1fps,
2fps, 3fps, 5fps, 8fps, 10fps, 12fps, and 15fps. You can also select Customize and manually enter a
value.

Note that the fixed-focal lens module can attain a frame rate of up to 30fps.



m Intra frame period
Determine how often to plant an | frame. The shorter the duration, the more likely you will get better
video quality, but at the cost of higher network bandwidth consumption. Select the intra frame period
from the following durations: 1/4 second, 1/2 second, 1 second, 2 seconds, 3 seconds, and 4 seconds.

m Video quality

Constant bit rate: A complex scene generally produces a larger file size, meaning that
higher bandwidth will be needed for data transmission. The bandwidth utilization is
configurable to match a selected level, resulting in mutable video quality performance.
The bit rates are selectable at the following rates: 20Kbps, 30Kbps, 40Kbps, 50Kbps, 64Kbps,
128Kbps, 256Kbps, 512Kbps, 768Kbps, 1Mbps, 2Mbps, 3Mbps, 4Mbps, 6Mbps, 8Mbps, and
16Mbps. You can also select Customize and manually enter a value up to 40Mbps.

- Target bit rate: select a bit rate from the pull-down menu. The bit rate ranges from 20kbps
to a maximum of 16Mbps. The bit rate then becomes the Average or Upper bound bit rate
number. The Network Camera will strive to deliver video streams around or within the bit

rate limitation you impose.

- Policy: If Frame Rate Priority is selected, the Network Camera will try to maintain
the frame rate per second performance, while the image quality will sometimes be

compromised. If Image quality priority is selected, the Network Camera might drop some
video frames in order to maintain image quality.

Fixed quality: On the other hand, if Fixed quality is selected, all frames are transmitted
with the same quality; bandwidth utilization is therefore unpredictable. The video quality
can be adjusted to the following settings: Medium, Standard, Good, Detailed, and
Excellent. You can also select Customize and manually enter a value.

- Maximum bit rate: With the guaranteed image quality, you might still want to place a bit
rate limitation to control the size of video streams for bandwidth and storage concerns.
The configurable bit rate starts from 1Mbps to 40Mbps.

The Maximum bit rate setting in the Fixed quality configuration can ensure a reasonable
and limited use of network bandwidth. For example, in low light conditions where a Fixed

quality setting is applied, video packet sizes can tremendously increase when noises are
produced with electrical gain.

You may also manually enter a bit rate number by selecting the Customized option.



If JPEG mode is selected, the Network Camera continuously sends JPEG images to the client, producing
a moving effect similar to a filmstrip. Every single JPEG image transmitted guarantees the same
image quality, which in turn comes at the expense of variable bandwidth usage. Because the media
contents are a combination of JPEG images, no audio data is transmitted to the client. There are three
parameters provided in MUPEG mode to control the video performance:

@ JPEG
Framme size: 16961696 -
Maximum frame rate: 1afns -
Yideo guality
Constant bit rate:
@ Fixed quality.
Quality: sood M
haximum hit rate: 40 Mhps h

m Frame size
You can set up different video resolution for different viewing devices. For example, set a smaller
frame size and lower bit rate for remote viewing on mobile phones and a larger video size and a higher
bit rate for live viewing on web browsers. Note that a larger frame size takes up more bandwidth.

m Maximum frame rate
This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother video
quality.
The frame rates are selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, and 15fps. You can also select
Customize and manually enter a value. The frame rate will decrease if you select a higher resolution.

Note that the fixed-focal lens module can attain a frame rate of up to 30fps.

m Video quality
Refer to the previous page setting an average or upper bound threshold for controlling the bandwidth
consumed for transmitting motion jpegs. The configuration method is identical to that for H.264.

ﬁ NOTE:

the Fixed q[/a//'ty menu, a lower value will prodube higher qua//'z‘);.

» Converting high-quality video may significantly increase the CPU loading, and you may encounter
streaming disconnection or video loss while capturing a complicated scene. In the event of occurance,
we suggest you customize a lower video resolution or reduce the frame rate to obtain smooth video.



Media > Audio

Audio Settings

Audio settings

Channel 1
[#] Mute
Internal mic rephone input gain: L 63%
Audio typs ) -
@G Dcnu[:]
© 3.726 bit rate: 32 Kbps [7]
Channel 2
[#] Mute
Internal mic rephone input gain: L 89%
Audio typs N o
@ GTI: pcnu[:]
) (3.726 bit rata: 32 -‘CstE

Save

Mute: Select this option to disable audio transmission from the Network Camera to all clients. Note that
if mute mode is turned on, no audio data will be transmitted even if audio transmission is enabled on the
Client Settings page. In that case, the following message is displayed:

The media type has been changed ta video only because the media from server contains no audio

Internal microphone input gain: Select the gain of the internal audio input according to ambient
conditions. Adjust the gain from -33dB (least) to 21dB (most).

Audio type: Select audio codec as G.711 or G.726 and the bit rate.

m G.711 provides good sound quality and requires about 64Kbps. Select pcmu (u-Law) or pcma (A-Law)
mode.

m G.726 is a speech codec standard covering voice transmission at rates of 16, 24, 32, and 40kbit/s.

When completed with the settings on this page, click Save to enable the settings.



Network > General settings
This section explains how to configure a wired network connection for the Network Camera.

Network Type Network type

@ LAN
@ GetlP address automatically
) Use fixed IP address
/| Enable UPnP presentation
Enable UPnP port forwarding
PPPOE

Enable IPvG

[ sae |
LAN
Select this option when the Network Camera is deployed on a local area network (LAN) and is intended
to be accessed by local computers. The default setting for the Network Type is LAN. Rememer to click
Save when you complete the Network setting.

Get IP _address automatically: Select this option to obtain an available dynamic IP address assigned by
the DHCP server each time the camera is connected to the LAN.

Use fixed IP address: Select this option to manually assign a static IP address to the Network Camera.

Network type
@ LAN
GetIP address automatically

@ Use fixed IP address

IF address: 192.168.4.108
Subnet mask: 2552552550
Default router: 192.168.4.1

Primary DMS: 192.168.0.10
Secandary DNS: 192.168.0.20
Primary WINS server: 192.168.0.10
Secondary WINS server: 192 168.0.20

7] Enable UPnP presentation
Enable UPnP port forwarding

PFPPoE
Enable IPvG

| Save |

1. You can make use of VIVOTEK Installation Wizard 2 on the software CD to easily set up the Network
Camera on LAN. Please refer to Software Installation on page 17 for details.
2. Enter the Static IP, Subnet mask, Default router, and Primary DNS provided by your ISP.

Subnet mask: This is used to determine if the destination is in the same subnet. The default value is
“255.255.255.0".

Default router: This is the gateway used to forward frames to destinations in a different subnet. Invalid
router setting will fail the transmission to destinations in different subnet.



Primary DNS: The primary domain name server that translates hostnames into IP addresses.

Secondary DNS: Secondary domain name server that backups the Primary DNS.

Primary WINS server: The primary WINS server that maintains the database of computer name and IP
address.

Secondary WINS server: The secondary WINS server that maintains the database of computer name
and IP address.

Enable UPnP presentation: Select this option to enable UPnP™ presentation for your Network Camera
so that whenever a Network Camera is presented to the LAN, shortcuts of connected Network Cameras
will be listed in My Network Places. You can click the shortcut to link to the web browser. Currently,
UPnP™ is supported by Windows XP or later. Note that to utilize this feature, please make sure the
UPnP™ component is installed on your computer.
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Enable UPnP port forwarding: To access the Network Camera from the Internet, select this option to

allow the Network Camera to open ports on the router automatically so that video streams can be sent
out from a LAN. To utilize of this feature, make sure that your router supports UPnP™ and it is activated.

PPPoE (Point-to-point over Ethernet)

Select this option to configure your Network Camera to make it accessible from anywhere as long as
there is an Internet connection. Note that to utilize this feature, it requires an account provided by your
ISP.

Follow the steps below to acquire your Network Camera’s public IP address.

1. Set up the Network Camera on the LAN.

2. Go to Configuration > Event > Event settings > Add server (please refer to Add server on page 103) to
add a new email or FTP server.

3. Go to Configuration > Event > Event settings > Add media (please refer to Add media on page 107).
Select System log so that you will receive the system log in TXT file format which contains the
Network Camera’s public IP address in your email or on the FTP server.

4. Go to Configuration > Network > General settings > Network type. Select PPPoE and enter the user
name and password provided by your ISP. Click Save to enable the setting.

LAN
@ PPPoE
User name:
Passwaord:
Confirm password:

Enable IPVE

| Save |

5. The Network Camera will reboot.
6. Disconnect the power to the Network Camera; remove it from the LAN environment.



_@ NOTE:

» If the default ports are already used by other devices connected to the same router, the Network
Camera will select other ports for the Network Camera.

» If UPnP™ is not supported by your router, you will see the following message:
Error: Router does not support UPnP port forwarding.

» Below are steps to enable the UPnP™ user interface on your computer:
Note that you must log on to the computer as a system administrator to install the UPnP™
components.

1. Go to Start, click Control Panel, then click Add or Remove Programs.

Pick o category
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2. In the Add or Remove Programs dialog box, click Add/Remove Windows Components.
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3. In the Windows Components Wizard dialog box, select Networking Services and click Details.
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4. In the Networking Services dialog box, select Universal Plug and Play and click OK.
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5. Click Next in the following window.
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6. Click Finish. UPnP™ js enabled.

» How does UPnP™ work?
UPnP™ networking technology provides automatic IP configuration and dynamic discovery of devices

added to a network. Services and capabilities offered by networked devices, such as printing and file
sharing, are available among each other without the need for cumbersome network configuration. In
the case of Network Cameras, you will see Network Camera shortcuts under My Network Places.

» Enabling UPnP port forwarding allows the Network Camera to open a secondary HTTP port on the
router-not HTTP port-meaning that you have to add the secondary HTTP port number to the Network
Camera’s public address in order to access the Network Camera from the Internet. For example,
when the HTTP port is set to 80 and the secondary HTTP port is set to 8080, refer to the list below for

the Network Camera’s IP address.

From the Internet In LAN

http://203.67.124.123:8080 http://192.168.4.160 or
http://192.168.4.160:8080

» If the PPPoE settings are incorrectly configured or the Internet access is not working, restore the
Network Camera to factory default; please refer to Restore on page 49 for details. After the Network

Camera is reset to factory default, it will be accessible on the LAN.



Enable IPv6
Select this option and click Save to enable IPv6 settings.

Please note that this only works if your network environment and hardware equipment support IPv6. The
browser should be Microsoft® Internet Explorer 6.5, Mozilla Firefox 3.0 or above.

Network type

LAMN
@ PPPoE
Username:
Password:
Confirm passwaord:

| Enable IPvG

IPvE information

Manually setup the IP address

| Save |

When IPv6 is enabled, by default, the network camera will listen to router advertisements and be
assigned with a link-local IPv6 address accordingly.

IPv6 Information: Click this button to obtain the IPv6 information as shown below.

[eth0 address]
fed0:0000:0000:0000:0202:d1ff-fe0e:d4c8/64 @Link
[Gateway]

IPvE address list of gateway

[DNS]

IPv6 address list of DNS

If your IPv6 settings are successful, the IPv6 address list will be listed in the pop-up window. The IPv6
address will be displayed as follows:

Refers to Ethernet

[eth) address]

2001 008 2500: 00020202 A -fe(M 658454 @ Glokal Link-global IPv6 address/network mask
fieB0:0000:0000:0000:0202:d1 £ fe0d £5f4 84 @Link Link-local IPv6 address/network mask
[Gateway]

fe80: 211 d3ff fea: 102k

[DNE]

2000050978



Please follow the steps below to link to an IPv6 address:

1. Open your web browser.

2. Enter the link-global or link-local IPv6 address in the address bar of your web browser.
3. The format should be:

http://[2001:0c08:2500:0002:0202:d 1ff:fe04:65f4]/

T

IPvé address

4. Press Enter on the keyboard or click Refresh button to refresh the webpage.

For example:
2 Network Camera - Microsoft Internet Explorer

File Edt View Favorites Took Help

@Ba{k - &I Jﬂ :] ; - Search S.( Favorkes .&‘A‘. ; 3 E :‘i

Address | @] hitp://[2001:0c08:2500:0002:0202:d 1#f:fe04:65f4]/

NOTE:

» If you have a Secondary HTTP port (the default value is 8080), you can also link to the webpage in
the following address format: (Please refer to HTTP streaming on page 72 for detailed information.)

http://[2001:0c08:2500:0002:0202:d 1ff:fe04:6 5f4]/

t )

IPvé address

» If you choose PPPoE as the Network Type, the [PPP0O address] will be displayed in the IPv6
information column as shown below.

[eth( address]
$e 0000000000000 0202: d1 f1:fel 1:2290404 @Link

[pppl address]
F R0 QOO0 00002 A1 el 12200 0@ Link

20011000 :0002:0202-d1 1] 1. 229044 @lobal

[Gateway]
fied0:- 90 1a00:4 142 Beed

[DMNE]
2001 k000:1

Manually setup the IP address: Select this option to manually set up IPv6 settings if your network
environment does not have DHCPV6 server and router advertisements-enabled routers.

If you check this item, the following blanks will be displayed for you to enter the corresponding
information:

/| Enable IPvG
IPvE information
V| Manually setup the IP address
Optional IP address / Prefix length ! 64
Optional default router

Optional primary DNS



VIVOTEK

Port
port
HTTPS port
-

| Sawe

HTTPS port: By default, the HTTPS port is set to 443. It can also be assigned to another port number
between 1025 and 65535.

FTP port: The FTP server allows the user to save recorded video clips. You can utilize VIVOTEK's

Installation Wizard 2 to upgrade the firmware via FTP server. By default, the FTP port is set to 21, or
assigned to another port number between 1025 and 65535.

User's Manual - 71




Network > Streaming protocols

HTTP streaming

To utilize HTTP authentication, make sure that your have set a password for the Network Camera first;
please refer to Security > User account on page 83 for details.

HTTP streaming || RTSP sireaming

Authentic ation: basic -
HTTP port: Go
Secondary HTTF port: G030

Access name for channel 1

Stream 1: video.mipg
Stream 2: videos2 mipg
Stream 3 videos3.mipg

Access name for channel 2

Stream 1: video2.mipg
Stream 2: videoZs 2 mipg
Stream 3: videoZ= 3. mipg

| Save |

Authentication: Depending on your network security requirements, the Network Camera provides two
types of security settings for an HTTP transaction: basic and digest.

If basic authentication is selected, the password is sent in plain text format and there can be potential
risks of being intercepted. If digest authentication is selected, user credentials are encrypted using MD5
algorithm and thus provide better protection against unauthorized access.

HTTP port / Secondary HTTP port: By default, the HTTP port is set to 80 and the secondary HTTP port is
set to 8080. They can also be assigned to another port number between 1025 and 65535. If the ports are
incorrectly assigned, the following warning messages will be displayed:

Microsoft Internet Explorer,

Microsoft Internet Explorer

! E HTTP port must be 80 or From 1025 to 65535 ! ': Secondary HTTP port must be from 1025 ta 65535
-

To access the Network Camera on the LAN, both the HTTP port and secondary HTTP port can be used
to access the Network Camera. For example, when the HTTP port is set to 80 and the secondary HTTP
port is set to 8080, refer to the list below for the Network Camera’s IP address.

On the LAN

http://192.168.4.160 or
http://192.168.4.160:8080

Access name for Channel # and stream #: This Network camera supports multiple streams
simultaneously. The access name is used to differentiate the streaming source. Users can click Media >
Video > Stream settings to set up the video quality of linked streams. For more information about how
to set up the video quality, please refer to Stream settings on page 59.

When using Mozilla Firefox or Netscape to access the Network Camera and the video mode is set to
JPEG, users will receive video comprised of continuous JPEG images. This technology, known as “server
push”, allows the Network Camera to feed live pictures to Mozilla Firefox and Netscape.



URL command -- http://<ip address>:<http port>/<access name for stream 1 ~ 3>
For example, when the Access name for stream 2 is set to video2.mjpg:

1. Launch Mozilla Firefox or Netscape.

2. Type the above URL command in the address bar. Press Enter.

3. The JPEG images will be displayed in your web browser.

©) yvideo2.mjpg (JPEG Image, 320x240 pixels) - Mozilla Firefox

File Edit \iew History Bookmarks Tools  Help
@€ - - & €9 | hups192.168.5.151video2.mipg || B] [Cl+]co0i

|:| Customize Links |:| Free Hotmail |:| Wwindows Media |:| Windows
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7
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A IMPORTANT:

» Microsoft® Internet Explorer does not support server push technology; therefore, using http.//<ip
address>:<http port>/<access name for stream 1 ~ 3> will fail to access the Network Camera.

» Users can only use URL commands to request the stream 5. For more information about URL
commands, please refer to page 127.

RTSP Streaming
To utilize RTSP streaming authentication, make sure that you have set a password for the Network

Camera first; please refer to Security > User account on page 83 for details.
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Authentication: Depending on your network security requirements, the Network Camera provides three
types of security settings for streaming via RTSP protocol: disable, basic, and digest.

If basic authentication is selected, the password is sent in plain text format, but there can be potential
risks of it being intercepted. If digest authentication is selected, user credentials are encrypted using
MD5 algorithm, thus providing better protection against unauthorized access.

The availability of the RTSP streaming for the three authentication modes is listed in the following table:

Quick Time player VLC Player
Disable o) O
Basic (0] (0]
Digest (0) X

Access name for Channel # and stream #: This Network camera supports multiple streams

simultaneously. The access name is used to differentiate the streaming source.

If you want to use an RTSP player to access the Network Camera, you HAVE TO set the video mode to

H.264 and use the following RTSP URL command to request transmission of the streaming data.

rtsp://<ip address>:<rtsp port>/<access name for stream1 ~ 3>

For example, when the access name for stream 1 is set to live.sdp:

1. Launch an RTSP player.

2. Choose File > Open URL. A URL dialog box will pop up.

3. Type the above URL command in the address field.

4. The live video will be displayed in your player as she
below.

Eirdet oy Inderrd IR b epaern

Hsp://192.168.5,1511554 »

) PEr]

ﬁ NOTE:

An original, circular view will be displayed using all RTSP players. For access to the Regional
Vlews you can install VIVOTEK's ST7501 or VAST software. You can right-click on a live view

. window to see the Display mode
“Sorsten | M| Viers. . Cooliguintion.... Layot..i Hids. OptlonS.




RTSP port /RTP port for video, audio/ RTCP port for video, audio

m RTSP (Real-Time Streaming Protocol) controls the delivery of streaming media. By default, the port
number is set to 554.

m The RTP (Real-time Transport Protocol) is used to deliver video and audio data to the clients. By
default, the RTP port for video is set to 5556 and the RTP port for audio is set to 5558.

m The RTCP (Real-time Transport Control Protocol) allows the Network Camera to transmit the data by
monitoring the Internet traffic volume. By default, the RTCP port for video is set to 5557 and the RTCP
port for audio is set to 5559.

The ports can be changed to values between 1025 and 65535. The RTP port must be an even number
and the RTCP port is the RTP port number plus one, and thus is always an odd number. When the RTP
port changes, the RTCP port will change accordingly.

If the RTP ports are incorrectly assigned, the following warning message will be displayed:

Microsoft Internet Explorer

! \ Irvalid port number, RTP video port must be an even numbet,
.

[ ok




Multicast settings for channel # and stream 1 ~ 3: Click the items to display the detailed configuration
information. Select the Always multicast option to enable multicast for streams 1 ~ 3.

Multicast settings for channel 2

= Siream 1
Alwi ays multic st
Multic st group address: 2301281102
Wultic ast video port: 5572
Wultic ast RTCP video port:
hultic a5t audio port: 5574
ultic st RTCP audic port:
Multic gzt TTL [1~255]: 15
¢ Siream 2
Albw ays multic ast
Wultic st group address: 2391281103
hultic szt video port: S576
hultic st RTCP video port:
hultic szt audio port: 5578
hultic st RTCP audio port:

Multicast TTL [1~255]: 15
& Stream3

Unicast video transmission delivers a stream through point-to-point transmission; multicast, on the other
hand, sends a stream to the multicast group address and allows multiple clients to acquire the stream at
the same time by requesting a copy from the multicast group address. Therefore, enabling multicast can
effectively save Internet bandwith.

The ports can be changed to values between 1025 and 65535. The multicast RTP port must be an even
number and the multicast RTCP port number is the multicast RTP port number plus one, and thus is
always odd. When the multicast RTP port changes, the multicast RTCP port will change accordingly.

If the multicast RTP video ports are incorrectly assigned, the following warning message will be
displayed: B ————

Microsoft Internet Explorer.

! E Invalid port number. Multicast stream 1 video port must be an even number,
L3

[ ex |

Multicast TTL [1~255]: The multicast TTL (Time To Live) is the value that tells the router the range a
packet can be forwarded.

Initial TTL Scope

0 Restricted to the same host

1 Restricted to the same subnetwork
32 Restricted to the same site

64 Restricted to the same region

128 Restricted to the same continent
255 Unrestricted in scope




Network > DDNS

This section explains how to configure the dynamic domain name service for the Network
Camera. DDNS is a service that allows your Network Camera, especially when assigned
with a dynamic IP address, to have a fixed host and domain name.

Manual setup

DDNS: Dynamic domain name service
DDNS: Dynamic domain name service
[] Enable DDMS:
Frovider: Dyndns orgiDynamic) »
Host name:

User name:

Password:

Enable DDNS: Select this option to enable the DDNS setting.

Provider: Select a DDNS provider from the provider drop-down list.

VIVOTEK offers Safe100.net, a free dynamic domain name service, to VIVOTEK customers. It
is recommended that you register Safe100.net to access VIVOTEK’s Network Cameras from the
Internet. Additionally, we offer other DDNS providers, such as Dyndns.org(Dynamic), Dyndns.
org(Custom), Safe100.net, and CustomSafe100.

Note that before utilizing this function, please apply for a dynamic domain account first.

m Safe100.net

1. In the DDNS column, select Safe100.net from the drop-down list. Click | accept after reviewing
the terms of the Service Agreement.

2. In the Register column, fill in the Host name (xxxx.safe100.net), Email, Key, and Confirm Key,
and click Register. After a host name has been successfully created, a success message will
be displayed in the DDNS Registration Result column.

Register
Host name: W’I’K.
Email: wik@vivotek.com
Key: sass
Confirm key: rene

To apply for a domain name for the camera, or to modify the previously registered information, fill in

the following fields and then click "Reqgister”.

DDME Registration Result:

[Register] Successfully Your account information has 25
been mailed to registered e-mail address

W

Upon successful registration, you can clickm{o automatically upload relevant information to the

DDME form or you can manually fill it in. Then, click "Save” to save new settings.



3. Click Copy and all the registered information will automatically be uploaded to the corresponding
fields in the DDNS column at the top of the page as seen in the picture.

DDNS: Dynamic domain name service

Enahle DDMNS:

Frovider: Safe100.net A4
Host name: WVWTK. safe100.net [*.safe100.net]
Email: wik@vivotek.com
KEYJ adaa
Register

Host name: WVVTK. safe100.net

Email: wik@vivotek.com

Key: sane Forget key

Confirm key: T

To apply for a domain name for the camera, or to modify the previously registered information, fill in

the following fields and then click "Register”.

DDME Reagistration Result:

[Register] Successfully Your account information has A

been mailed to registered e-mail address T

Upon successful registration, you can click copy to automatically upload relevant information to the

DOME form or you can manually fill itin. Then, click "Save™ to save new settings.
4. Select Enable DDNS and click Save to enable the setting.

m CustomSafe100

VIVOTEK offers documents to establish a CustomSafe100 DDNS server for distributors and
system integrators. You can use CustomSafe100 to register a dynamic domain name if your
distributor or system integrators offer such services.

1. In the DDNS column, select CustomSafe100 from the drop-down list.

2. In the Register column, fill in the Host name, Email, Key, and Confirm Key; then click Register.
After a host name has been successfully created, you will see a success message in the DDNS
Registration Result column.

3. Click Copy and all for the registered information will be uploaded to the corresponding fields in
the DDNS column.

4. Select Enable DDNS and click Save to enable the setting.

Forget key: Click this button if you have forgotten the key to Safe100.net or CustomSafe100. Your
account information will be sent to your email address.

Refer to the following links to apply for a dynamic domain account when selecting other
DDNS providers:
m Dyndns.org(Dynamic) / Dyndns.org(Custom): visit http://www.dyndns.com/


http://www.dyndns.com/

Express link

Express Link is a free service provided by VIVOTEK server, which allows users to register
a domain name for a network device. One URL can only be mapped to one MAC address.
This service will examine if the host name is valid and automatically open a port on your

router. If using DDNS, the user has to manually configure UPnP port forwarding. Express
Link is more convenient and easier to set up.

Manual setup | | Express link

+| Enable express link

hitp:# Zbtherenet  Help Save

By Express link, all uzers need to do iz create host name for the camera. i w ill generate the link to
access the camera from Internet.

Please follow the steps below to enable Express Link:

1. Make sure that your router supports UPnP port forwarding and it is activated.
2. Check Enable express link.

3. Enter a host name for the network device and click Save. If the host name has been used by

another device, a warning message will show up. If the host name is valid, it will display a
message as shown below.

Manual setup | | Express link

http: wvivotek_test3ds4 2bthere.net Help Saye |

The camera can now be accessed at httpuivivotek test3454.2bthere.net

‘23 Network Camera - Microsoft Internet Explorer
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Network > QoS (Quality of Service)

Quality of Service refers to a resource reservation control mechanism, which guarantees a certain quality
to different services on the network. Quality of service guarantees are important if the network capacity
is insufficient, especially for real-time streaming multimedia applications. Quality can be defined as, for
instance, a maintained level of bit rate, low latency, no packet dropping, etc.

The following are the main benefits of a QoS-aware network:
m The ability to prioritize traffic and guarantee a certain level of performance to the data flow.

m The ability to control the amount of bandwidth each application may use, and thus provide higher
reliability and stability on the network.

Requirements for QoS

To utilize QoS in a network environment, the following requirements must be met:
m All network switches and routers in the network must include support for QoS.
m The network video devices used in the network must be QoS-enabled.

QoS models

IEEE802.1p defines a QoS model at OSI Layer 2 (Data Link Layer), which is called CoS, Class of
Service. It adds a 3-bit value to the VLAN MAC header, which indicates the frame priority level from 0
(lowest) to 7 (highest). The priority is set up on the network switches, which then use different queuing
disciplines to forward the packets.

Below is the setting column for CoS. Enter the VLAN ID of your switch (0~4095) and choose the priority
for each application (0~7).

Co5S

/| Enable CoS
VLAN 1D 1
Live video: 0 -
Live audio: o -
EventlAlarm: 0 -

Management: o -

If you assign Video the highest priority level, your network switch will handle video packets first.

@ NOTE:

» A VLAN-capable Switch (802.1p) is required. Web browsing may fail if the CoS setting is incorrect.

» Class of Service technologies do not guarantee a level of service in terms of bandwidth and delivery
time; they offer a “best-effort.” Users can think of CoS as “coarsely-grained” traffic control and QoS as
“finely-grained” traffic control.

» Although CoS is simple to manage, it lacks scalability and does not offer end-to-end guarantees since
it is based on L2 protocol.



DSCP-ECN defines QoS at Layer 3 (Network Layer). The Differentiated Services (DiffServ) model is
based on packet marking and router queuing disciplines. The marking is done by adding a field to the
IP header, called the DSCP (Differentiated Services Codepoint). This is a 6-bit field that provides 64
different class IDs. It gives an indication of how a given packet is to be forwarded, known as the Per Hop
Behavior (PHB). The PHB describes a particular service level in terms of bandwidth, queueing theory,
and dropping (discarding the packet) decisions. Routers at each network node classify packets according
to their DSCP value and give them a particular forwarding treatment; for example, how much bandwidth
to reserve for it.

Below are the setting options of DSCP (DiffServ Codepoint). Specify the DSCP value for each application
(0~63). R
QoS/DSCP

/| Enable QoS/DSCP

Live video: u
Live audio: 0
Event/Alarm: u
Management: 0

Save




Network > SNMP (Simple Network Management Protocol)

This section explains how to use the SNMP on the network camera. The Simple Network
Management Protocol is an application layer protocol that facilitates the exchange of
management information between network devices. It helps network administrators to remotely
manage network devices and find, solve network problems with ease.

m The SNMP consists of the following three key components:

1. Manager: Network-management station (NMS), a server which executes applications that monitor and
control managed devices.

2. Agent: A network-management software module on a managed device which transfers the status of
managed devices to the NMS.

3. Managed device: A network node on a managed network. For example: routers, switches, bridges,
hubs, computer hosts, printers, IP telephones, network cameras, web server, and database.

Before configuring SNMP settings on the this page, please enable your NMS first.

SNMP Configuration

Enable SNMPv1, SNMPv2c
Select this option and enter the names of Read/Write community and Read Only community according to
your NMS settings.

Enable SNMPv1, SNMPv2c

SHMPv1, SHMPv2c Settings
Read/\Write community: Private

Read only community: Fublic

Enable SNMPv3
This option contains cryptographic security, a higher security level, which allows you to set the
Authentication password and the Encryption password.

m Security name: According to your NMS settings, choose Read/Write or Read Only and enter the
community name.

m Authentication type: Select MD5 or SHA as the authentication method.
m Authentication password: Enter the password for authentication (at least 8 characters).

m Encryption password: Enter a password for encryption (at least 8 characters).
Enahle SMMPv3

SHMPv3 Settings
Read/\Write Security name;  Frivate
Authentication Type: MD5 »
Authentication Password:
Encryption Password:
Read only Security name:  Fublic
Authentication Type: MD5 «
Authentication Password:

Encryption Passwoard:



Security > User Account

This section explains how to enable password protection and create multiple accounts.

Root Password

Root password | | Privilege management | | Account management

Root password:

Confirm root password: | Save

The administrator account name is “root”, which is permanent and can not be deleted. If you want to add

more accounts in the Manage User column, please apply the password for the “root” account first.

1. Type the password identically in both text boxes, then click Save to enable password protection.

2. A window will prompt for authentication; type the correct user’'s name and password in their respective
fields to access the Network Camera.

Privilege management

Root password | | Privilege management | | Account management

Allow anenymous viewing
Operator: /| Digital output | PTZ control

Viewer: Digital output | PTZ control | Save

Digital Output & PTZ control: You can modify the management privilege as operators or viewers. Select
or de-select the checkboxes, and then click Save to enable the settings. If you give Viewers the privilege,
Operators will also have the ability to control the Network Camera through the main page. (Please refer
to Configuration on page 41).

Allow anonymous viewing: If you select this item, any client can access the live stream without entering a
User ID and Password.

Account management

Root password | | Privilege management | | Account management

Existing user name: —Add new user— El

User name:
User password:
Confirm user password: | Add |

Privilege:

Viewer

Administrators can create up to 20 user accounts.
1. Input the new user’s name and password.
2. Select the privilege level for the new user account. Click Add to enable the setting.

Access rights are sorted by user privilege (Administrator, Operator, and Viewer). Only administrators can
access the Configuration page. Though operators cannot access the Configuration page, they can use
the URL Commands to get and set the value of parameters. For more information, please refer to URL
Commands of the Network Camera on page 126. Viewers access only the main page for live viewing.

Here you also can change a user’s access rights or delete user accounts.
1. Select an existing account to modify.
2. Make necessary changes and click Update or Delete to enable the setting.



Security > HTTPS (Hypertext Transfer Protocol over SSL)

This section explains how to enable authentication and encrypted communication over SSL
(Secure Socket Layer). It helps protect streaming data transmission over the Internet on higher
security level.

Create and Install Certificate Method

Before using HTTPS for communication with the Network Camera, a Certificate must be created first.
There are three ways to create and install a certificate:

Create self-signed certificate

1. Select the first option.

2. Check Enable HTTPS secure connection, t